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Learning Objectives
• Describe the purpose of the RStudio Script, Console, Environment, and Plots panes.
• Organize files and directories for a set of analyses as an R Project, and understand the
purpose of the working directory.
• Use the built-in RStudio help interface to search for more information on R functions.
• Demonstrate how to provide sufficient information for troubleshooting with the R user
community.
These lesson materials were produced by the Data Carpentry team. In case you landed here directly and want
more general information on these materials, see the home page (link in the header above). The materials
have been edited and added to by the team at EMBL.

What is R? What is RStudio?
The term “R” is used to refer to both the programming language and the software that interprets the scripts
written using it.
RStudio is currently a very popular way to not only write your R scripts but also to interact with the R
software. To function correctly, RStudio needs R and therefore both need to be installed on your computer.

Why learn R?
R does not involve lots of pointing and clicking, and that’s a good thing
The learning curve might be steeper than with other software, but with R, the results of your analysis do not
rely on remembering a succession of pointing and clicking, but instead on a series of written commands, and
that’s a good thing! So, if you want to redo your analysis because you collected more data, you don’t have to
remember which button you clicked in which order to obtain your results; you just have to run your script
again.
Working with scripts makes the steps you used in your analysis clear, and the code you write can be inspected
by someone else who can give you feedback and spot mistakes.
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Working with scripts forces you to have a deeper understanding of what you are doing, and facilitates your
learning and comprehension of the methods you use.
R code is great for reproducibility
Reproducibility is when someone else (including your future self) can obtain the same results from the same
dataset when using the same analysis.
R integrates with other tools to generate manuscripts from your code. If you collect more data, or fix a
mistake in your dataset, the figures and the statistical tests in your manuscript are updated automatically.
An increasing number of journals and funding agencies expect analyses to be reproducible, so knowing R will
give you an edge with these requirements.
R is interdisciplinary and extensible
With 10,000+ packages that can be installed to extend its capabilities, R provides a framework that allows
you to combine statistical approaches from many scientific disciplines to best suit the analytical framework
you need to analyze your data. For instance, R has packages for image analysis, GIS, time series, population
genetics, and a lot more.
R works on data of all shapes and sizes
The skills you learn with R scale easily with the size of your dataset. Whether your dataset has hundreds or
millions of lines, it won’t make much difference to you.
R is designed for data analysis. It comes with special data structures and data types that make handling of
missing data and statistical factors convenient.
R can connect to spreadsheets, databases, and many other data formats, on your computer or on the web.
R produces high-quality graphics
The plotting functionalities in R are endless, and allow you to adjust any aspect of your graph to convey
most effectively the message from your data.
R has a large and welcoming community
Thousands of people use R daily. Many of them are willing to help you through mailing lists and websites
such as Stack Overflow, or on the RStudio community.
Not only is R free, but it is also open-source and cross-platform
Anyone can inspect the source code to see how R works. Because of this transparency, there is less chance for
mistakes, and if you (or someone else) find some, you can report and fix bugs.

Knowing your way around RStudio
Let’s start by learning about RStudio, which is an Integrated Development Environment (IDE) for working
with R.
The RStudio IDE open-source product is free under the Affero General Public License (AGPL) v3. The
RStudio IDE is also available with a commercial license and priority email support from RStudio, Inc.
We will use RStudio IDE to write code, navigate the files on our computer, inspect the variables we are going
to create, and visualize the plots we will generate. RStudio can also be used for other things (e.g., version
control, developing packages, writing Shiny apps) that we will not cover during the workshop.
RStudio is divided into 4 “Panes”: the Source for your scripts and documents (top-left, in the default layout),
your Environment/History (top-right), your Files/Plots/Packages/Help/Viewer (bottom-right), and
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Figure 1: RStudio interface screenshot.
Files/Plots/Packages/Help/Viewer, Console.

Clockwise from top left:

Source, Environment/History,

the R Console (bottom-left). The placement of these panes and their content can be customized (see menu,
Tools -> Global Options -> Pane Layout).
One of the advantages of using RStudio is that all the information you need to write code is available in a
single window. Additionally, with many shortcuts, autocompletion, and highlighting for the major file types
you use while developing in R, RStudio will make typing easier and less error-prone.

Getting set up
It is good practice to keep a set of related data, analyses, and text self-contained in a single folder, called the
working directory. All of the scripts within this folder can then use relative paths to files that indicate
where inside the project a file is located (as opposed to absolute paths, which point to where a file is on a
specific computer). Working this way makes it a lot easier to move your project around on your computer
and share it with others without worrying about whether or not the underlying scripts will still work.
RStudio provides a helpful set of tools to do this through its “Projects” interface, which not only creates
a working directory for you, but also remembers its location (allowing you to quickly navigate to it) and
optionally preserves custom settings and open files to make it easier to resume work after a break. Go through
the steps for creating an “R Project” for this tutorial below.
1. Start RStudio.
2. Under the File menu, click on New Project. Choose New Directory, then New Project.
3. Enter a name for this new folder (or “directory”), and choose a convenient location for it. This will be
your working directory for the rest of the day (e.g., ~/data-carpentry).
4. Click on Create Project.
It is very convenient to have a different “R Project” for each scientific project that you are working on.
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Organizing your working directory
Using a consistent folder structure across your projects will help keep things organized, and will also make
it easy to find/file things in the future. This can be especially helpful when you have multiple projects. In
general, you may create directories (folders) for scripts, data, and documents.
• data_raw/ & data/ Use these folders to store raw data and intermediate datasets you may create for the
need of a particular analysis. For the sake of transparency and provenance, you should always keep a copy
of your raw data accessible and do as much of your data cleanup and preprocessing programmatically (i.e.,
with scripts, rather than manually) as possible. Separating raw data from processed data is also a good
idea. For example, you could have files data_raw/tree_survey.area1.txt and ...area2.txt kept
separate from a data/tree.survey.csv file generated by the scripts/01.preprocess.tree_survey.R
script.
• documents/ This would be a place to keep manuscript outlines, drafts, and other text.
• fig/ This would be the place to keep figures that you produce from your scripts.
• scripts/ This would be the place to keep your R scripts for different analyses or plotting, and
potentially a separate folder for your functions (more on that later).
• Additional (sub)directories depending on your project needs.
For this workshop, we will need a data_raw/ folder to store our raw data, and we will use data/ for when
we learn how to export data as CSV files, and a fig/ folder for the figures that we will save.
• Under the Files tab on the right of the screen, click on New Folder and create a folder named
data_raw within your newly created working directory (e.g., ~/data-carpentry/). (Alternatively, type
dir.create("data_raw") at your R console.) Repeat these operations to create a data folder and a
fig folder.
• Click on the first icon on the top left of the screen (white square with green plus sign) and select “R
Script”. This will create a new R script for you. This is where you should write all your code today.
Save this as data-carpentry-script.R in your project (root) folder.
We are going to keep the script in the root of our working directory because we are only going to use one file
and it will make things easier.
Your working directory should now look like this:

Figure 2: How it should look like at the beginning of this lesson
The working directory
The working directory is an important concept to understand. It is the place from where R will be looking
for and saving the files. When you write code for your project, it should refer to files in relation to the root
of your working directory and only need files within this structure.
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Using RStudio projects makes this easy and ensures that your working directory is set properly. If you need
to check it, you can use getwd(). If for some reason your working directory is not what it should be, you can
change it in the RStudio interface by navigating in the file browser where your working directory should be,
and clicking on the blue gear icon “More”, and select “Set As Working Directory”. Alternatively you can use
setwd("/path/to/working/directory") to reset your working directory. However, your scripts should not
include this line because it will fail on someone else’s computer.

Interacting with R
The basis of programming is that we write down instructions for the computer to follow, and then we tell the
computer to follow those instructions. We write, or code, instructions in R because it is a common language
that both the computer and we can understand. We call the instructions commands and we tell the computer
to follow the instructions by executing (also called running) those commands.
There are two main ways of interacting with R: by using the console or by using script files (plain text files
that contain your code). The console pane (in RStudio, the bottom left panel) is the place where commands
written in the R language can be typed and executed immediately by the computer. It is also where the
results will be shown for commands that have been executed. You can type commands directly into the
console and press Enter to execute those commands, but they will be forgotten when you close the program
(or R crashes, or the session is ended).
Because we want our code and workflow to be reproducible, it is better to type the commands we want in the
script editor, and save the script. This way, there is a complete record of what we did, and anyone (including
our future selves!) can easily replicate the results on their computer.
RStudio allows you to execute commands directly from the script editor by using the Ctrl + Enter shortcut
(on Macs, Cmd + Return will work, too). The command on the current line in the script (indicated by the
cursor) or all of the commands in the currently selected text will be sent to the console and executed when
you press Ctrl + Enter. You can find other keyboard shortcuts in this RStudio cheatsheet about the RStudio
IDE.
If R is ready to accept commands, the R console shows a > prompt. If it receives a command (by typing,
copy-pasting or sent from the script editor using Ctrl + Enter), R will try to execute it, and when ready,
will show the results and come back with a new > prompt to wait for new commands.
If R is still waiting for you to enter more data because it isn’t complete yet, the console will show a + prompt.
It means that you haven’t finished entering a complete command. This is because you have not ‘closed’
a parenthesis or quotation, i.e. you don’t have the same number of left-parentheses as right-parentheses,
or the same number of opening and closing quotation marks. When this happens, and you thought you
finished typing your command, click inside the console window and press Esc; this will cancel the incomplete
command and return you to the > prompt.

How to learn more after the workshop?
The material we cover during this workshop will give you an initial taste of how you can use R to analyze
data for your own research. However, you will need to learn more to do advanced operations such as cleaning
your dataset, using statistical methods, or creating beautiful graphics. The best way to become proficient and
efficient at R, as with any other tool, is to use it to address your actual research questions. As a beginner,
it can feel daunting to have to write a script from scratch, and given that many people make their code
available online, modifying existing code to suit your purpose might make it easier for you to get started.
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Seeking help
Use the built-in RStudio help interface to search for more information on R functions
One of the fastest ways to get help, is to use the RStudio help interface. This panel by default can be found
at the lower right hand panel of RStudio. As seen in the screenshot, by typing the word “Mean”, RStudio
tries to also give a number of suggestions that you might be interested in. The description is then shown in
the display window.
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Figure 3: RStudio help interface.
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I know the name of the function I want to use, but I’m not sure how to use it
If you need help with a specific function, let’s say barplot(), you can type:
?barplot
If you just need to remind yourself of the names of the arguments, you can use:
args(lm)
I want to use a function that does X, there must be a function for it but I don’t know which
one…
If you are looking for a function to do a particular task, you can use the help.search() function, which
is called by the double question mark ??. However, this only looks through the installed packages for help
pages with a match to your search request
??kruskal
If you can’t find what you are looking for, you can use the rdocumentation.org website that searches through
the help files across all packages available.
Finally, a generic Google or internet search “R <task>” will often either send you to the appropriate package
documentation or a helpful forum where someone else has already asked your question.
I am stuck… I get an error message that I don’t understand
Start by googling the error message. However, this doesn’t always work very well because often, package
developers rely on the error catching provided by R. You end up with general error messages that might not
be very helpful to diagnose a problem (e.g. “subscript out of bounds”). If the message is very generic, you
might also include the name of the function or package you’re using in your query.
Asking for help
The key to receiving help from someone is for them to rapidly grasp your problem. You should make it as
easy as possible to pinpoint where the issue might be.
Try to use the correct words to describe your problem. For instance, a package is not the same thing as
a library. Most people will understand what you meant, but others have really strong feelings about the
difference in meaning. The key point is that it can make things confusing for people trying to help you. Be
as precise as possible when describing your problem.
If possible, try to reduce what doesn’t work to a simple reproducible example. If you can reproduce the
problem using a very small data frame instead of your 50,000 rows and 10,000 columns one, provide the
small one with the description of your problem. When appropriate, try to generalize what you are doing so
even people who are not in your field can understand the question. For instance instead of using a subset of
your real dataset, create a small (3 columns, 5 rows) generic one. For more information on how to write a
reproducible example see this article by Hadley Wickham.
Last, but certainly not least, always include the output of sessionInfo() as it provides critical information about your platform, the versions of R and the packages that you are using, and other information
that can be very helpful to understand your problem.
sessionInfo()
#>
#>
#>
#>
#>
#>

R version 4.0.3 (2020-10-10)
Platform: x86_64-pc-linux-gnu (64-bit)
Running under: Ubuntu 20.04.1 LTS
Matrix products: default
BLAS/LAPACK: /usr/lib/x86_64-linux-gnu/openblas-pthread/libopenblasp-r0.3.8.so
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#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>
#>

locale:
[1] LC_CTYPE=C.UTF-8
[4] LC_COLLATE=C.UTF-8
[7] LC_PAPER=C.UTF-8
[10] LC_TELEPHONE=C

LC_NUMERIC=C
LC_MONETARY=C.UTF-8
LC_NAME=C
LC_MEASUREMENT=C.UTF-8

attached base packages:
[1] stats
graphics grDevices utils
other attached packages:
[1] forcats_0.5.1
[4] purrr_0.3.4
[7] tibble_3.0.6
[10] knitr_1.31
loaded via a namespace
[1] tidyselect_1.1.0
[5] vctrs_0.3.6
[9] utf8_1.1.4
[13] glue_1.4.2
[17] readxl_1.3.1
[21] cellranger_1.1.0
[25] fansi_0.4.2
[29] scales_1.1.1
[33] hms_1.0.0
[37] cli_2.3.1
[41] pkgconfig_2.0.3
[45] lubridate_1.7.9.2
[49] rstudioapi_0.13

LC_TIME=C.UTF-8
LC_MESSAGES=C
LC_ADDRESS=C
LC_IDENTIFICATION=C

datasets

methods

base

stringr_1.4.0
dplyr_1.0.4
readr_1.4.0
tidyr_1.1.2
ggplot2_3.3.3
tidyverse_1.3.0
BiocManager_1.30.10

(and not attached):
xfun_0.21
haven_2.3.1
generics_0.1.0
htmltools_0.5.1.1
rlang_0.4.10
pillar_1.5.0
DBI_1.1.1
dbplyr_2.1.0
lifecycle_1.0.0
munsell_0.5.0
rvest_0.3.6
evaluate_0.14
highr_0.8
broom_0.7.5
backports_1.2.1
jsonlite_1.7.2
digest_0.6.27
stringi_1.5.3
tools_4.0.3
magrittr_2.0.1
ellipsis_0.3.1
xml2_1.3.2
assertthat_0.2.1 rmarkdown_2.7.2
R6_2.5.0
compiler_4.0.3

colorspace_2.0-0
yaml_2.2.1
withr_2.4.1
modelr_0.1.8
gtable_0.3.0
ps_1.5.0
Rcpp_1.0.6
fs_1.5.0
grid_4.0.3
crayon_1.4.1
reprex_1.0.0
httr_1.4.2

Where to ask for help?
• The person sitting next to you during the workshop. Don’t hesitate to talk to your neighbor during the
workshop, compare your answers, and ask for help. You might also be interested in organizing regular
meetings following the workshop to keep learning from each other.
• Your friendly colleagues: if you know someone with more experience than you, they might be able and
willing to help you.
• Stack Overflow’s [r]-tag: Most questions have already been answered, but the challenge is to use the
right words in the search to find the answers. If your question hasn’t been answered before and is well
crafted, chances are you will get an answer in less than 5 min. Remember to follow their guidelines on
how to ask a good question.
• The R-help mailing list: it is read by a lot of people (including most of the R core team), a lot of people
post to it, but the tone can be pretty dry, and it is not always very welcoming to new users. If your
question is valid (Read its Posting Guide), you are likely to get an answer very fast but don’t expect that
it will come with smiley faces. Also, here more than anywhere else, be sure to use correct vocabulary
(otherwise you might get an answer pointing to the misuse of your words rather than answering your
question). You will also have more success if your question is about a base function rather than a
specific package. blog.Revolutionanalytics.com and codeblog.jonskeet.uk also provide comprehensive
advice on how to ask programming questions.
• If your question is about a specific package, see if there is a mailing list for it. Usually it’s included in
the DESCRIPTION file of the package that can be accessed using packageDescription("name-ofpackage"). You may also want to try to email the author of the package directly, or open an issue on
the code repository (e.g., GitHub).
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• There are also some topic-specific mailing lists (GIS, phylogenetics, etc…), the complete list is here.
More resources
• The Introduction to R can also be dense for people with little programming experience but it is a good
place to understand the underpinnings of the R language.
• The R FAQ is dense and technical but it is full of useful information.
• The reprex package is very helpful to create reproducible examples when asking for help. Its usage and
philosophy are explained in rOpenSci’s community call “How to ask questions so they get answered”.
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